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Equipment Library

All of the library screens are fairly self-explanatory.    Just fill in the blanks to complete your record.    Use 
this library for tracking all of your instruments and equipment.    Like all of the libraries, you can customize 
the drop down boxes to fit your specific needs by pulling down the File menu, selecting Preferences, and 
[Clicking] on the Music tab.    There is room for you to track virtually all information pertaining to a specific 
piece of equipment. 

Menu Commands:
File
Edit
Record
Library
Help

Field Descriptions

Toolbar Buttons
Status Bar



Music Library

All of the library screens are fairly self-explanatory.    Just fill in the blanks to complete your record.    Each 
of the drop down boxes are user-defineable which means you can customize the library to fit your 
individual needs.    In fact, by customizing the drop down boxes the Music Library can become much more 
than just a music library.    It can catalog octavos, solo literature, piano literature, orchestral literature, 
videos, recordings, tapes, CDs, trax, collections and many other items.    To customize the drop down lists 
pull down the File menu, select the Preferences menu item, and [Click] the Music tab.    If you take time to 
organize and customize the library, it will adapt to your own personal way of organization. 

Menu Commands:
File
Edit
Record
Library
Help

Field Descriptions

Toolbar Buttons
Status Bar



Getting Started

Selecting a Date

Select a date for the program order in Program Master (the list of entries for a program) using the 
Calendar Area on the upper left side of the program window.    Change months and years using the 
buttons below the calendar area or the items in the Calendar    Menu at the top of the screen.    The date 
and the day of the week will be displayed above the calendar in the Program Date box.    Just [Click] on 
the date in the month you want.    Once a date has been selected for the program, items may be entered 
into the program order.    (Hint:    Try [Double-Clicking] on the Calendar's Month/Year bar.    A Jump To box 
will appear where you can specify a specific month / day / year.

When a date is selected, a program order will be displayed if one exists for the selected day.    If a 
program order does not exist for the date selected, a blank program order is available to immediately 
enter information.



Calendar Area

This area of the Program Master program screen resembles a monthly calendar.    It is used to select 
dates for program orders.    The Program Title text box displays the title for the program order, and may be 
edited and changed as necessary.    The Program Date panel displays the weekday and date for the 
current program.    The current month and year are displayed in the small panel directly above the 
calendar grid.    This Month/Year panel, when double-clicked, displays the Jump to Month/Day/Year    
dialog box for quick changes.    The calendar displays the days of the current month for the current year.    
The buttons below the calendar allow changes in the month and year, as well as a button to jump directly 
to the current date. 

To change to the program order for a particular date, simply [Click] on the day of the month desired and 
the program order for that date, if one exists, will be displayed.    If you [Click] on a date with no program 
order, a blank program order will be shown.    You may enter information for this date immediately.    If you 
would like to add another program on a date, click on the Add New button in the toolbar.

The calendar area will be updated to match the date of the current program order if ToolBar Buttons    or 
the Menu are used to change to another program order.    Also, the calendar area will be updated to the 
program order date as you search through the program orders. 



Jump To Month/Day/Year

To jump to a specific month, day and year, select the Jump item in the Program Master Calendar Menu or 
[Double-Click] on the panel showing the current month and year above the calendar. 

Select the month desired with the month drop down list.    Type the desired day and year into the 
appropriate text boxes.    [Click] on [OK] to change the calendar to the new month, day and year.



Getting Started

Entering the Program Order

The right side of the Program Master program window is the Program Order Area.    This area shows a list 
of entries for the program on the date selected.    Program order entries may be moved, deleted, and 
edited until the exact order that is desired is created.    Before entering items in the program order,    type a 
title into the Program Title box above the calendar.    The title may be anything, but may not exceed 50 
characters in length. 

To add songs or custom events into the program order, [Double-Click] on a blank line in the program 
order, [click] on the Edit Line icon in the ToolBar, press [ENTER] when a line is selected, or select the Edit 
Line item in the Program menu.    Any of these methods will bring up the Edit Line    dialog box.    From this 
dialog box, a specific song, current song, or custom event may be entered.    Once the selections are 
made, [Clicking] on the [OK] button in the dialog box    will add the new event to the program order on the 
selected line.

Additional lines may be entered in the same way.    The lines may be moved up, moved down, deleted, or 
edited using the buttons on the toolbar or items in the Program menu. 

When a program order is saved, the date for that program will be saved into the songbook database for 
each song used - this will allow you to see the last four dates when a song was used.    The Dates Used 
text boxes of the Songbook Browser, Quick Browser and the Available Songs section of the main screen, 
will always show the four most recent dates that a song was used. 



Program Order Area

This area of the Program Master program screen is used to enter and edit program order entries and 
events. To add a new song or custom event, use the Edit Line menu item in the Program    menu, [Click] 
on the Edit Line button in the ToolBar , or [Double-Click] on an empty line in the program order.    Any of 
these methods will bring up the Edit Line dialog box.    In this dialog box, a specific song may be selected 
by number or a custom event may be entered.    By default, the currently selected song will appear in the 
Edit Line box.    (The currently selected song is determined by the song that is visible in the Available 
Songs scroll box at the bottom of the screen.)    If you desire to enter a different song, simply type the 
number in the Song # box, and the appropriate information will appear to the right of the dialog box.    If 
you desire to enter an event other than a song, [Click] on the Other Item bullet and the song information 
disappears.    Enter the appropriate information in the boxes at the right of the Edit Line dialog box.    
[Click] [OK] to enter the song or other event into the program order.    (Hint: For quick entry of songs, 
simply [Double-Click] on a blank line in a program order.    The Edit Line box will appear with the currently 
selected song hilighted.    Simply type right over the currently selected song to quickly add the song that 
you desire.) 

By default, the song number and songbook title will appear in the Item and Comment boxes respectively. 
You can edit any of this information by simply typing over the default information in the Edit Line dialog 
box.    Continue to add new events in this way until    the program order is complete.

Once there are several entries in the Program Order Area, they may be moved, deleted, and edited using 
the Program Menu or buttons on the toolbar.      First, [Click] on the line to hilight it.    Then, choose the 
appropriate action to move the title up or down in the order, delete it, or edit it.    As a shortcut, [Double-
Clicking] on a line that already contains an event will bring up the Edit Line dialog box for event editing.      
Also, if you hilight a line that has a song entry, and press the right mouse button, the Quick Browser is 
loaded to display information about that song.

Some options    are also available for formatting in the grid.    The font may be made bold or normal in the 
Preferences dialog.    Also, the button in the upper right of the grid is used to switch between normal and 
wide view.    Wide view allows easier arranging and viewing of the program order.

The program orders may be searched for a specific word or phrase.    Use the Search Program Orders 
button, or use the Search For    item in the Program Order menu to bring up the Search Program Orders 
dialog box.    If a Title/Event was highlighted, that text will be put into the search text box by default.    
Otherwise, the current song in the song drop down list box at the bottom of the screen will be put in the 
search text box.    If these two choices are not desired, you may type any text into the search text box.    
Then, the program orders may be searched for the desired text.    If any programs contain the search text, 
they will be listed in a list box.    This list of program orders may be copied to the clipboard or exported to 
write.

Once the program order is arranged properly, it will be saved when another date or action is selected.    
Alternately, use the File/Save menu command to immediately save the new or changed program order.



Edit Line

To add a new song or custom event to the program order, select the Edit Line item in the Program menu, 
or [Click] on the Edit Line button in the ToolBar.    The Edit Line dialog box will displayed.

First, decide if a song or custom event is to be entered.    If a song is desired, and the song number is 
known, simply type the number into the Song # text box.    If the song desired is the one last selected in 
the Available Songs Scroll box at the bottom of the screen, the song number and title will be already be 
displayed.      Simply [Click] [OK] to enter the information into the program order.      For either case, the 
item or comment boxes may be edited. 

If a custom event is desired, such as a prayer or special music, etc.; choose the Custom Event radio 
button and enter the title of the event to be added.    Also, enter an item or comment, if desired, for this 
event. 

Multiple lines may be entered into these fields also.    This is useful for readings or choruses that need to 
have words in the program order.    To enter multiple lines, press return at the end of each line to start a 
new line.    Sometimes, if the grid is too narrow, long lines will    wrap before the return carriage.    This is 
normal and can    be corrected by widening the grid, or making the font not bold.

Once the new event has been entered properly, [Click] the [OK] button to add the event to the program 
order.    If the event needs to be moved, use the menu items or toolbar buttons.



Search Program Orders

To search all program orders for a phrase or other text, select the Search for...    item in the Program    
menu, or [Click] on the Search Program Orders button in the ToolBar.    The Search Program Orders 
dialog box will be displayed.

Type the text to search for into the text box.    Once the text to search for has been entered, [Click] [OK] to 
start the search.    The program will search all program orders for the text desired. 

After the search, the Browse List is displayed that lists the date and program title for all of the program 
orders that were found to match the search criteria.    [Click] on a date in the list box to display that 
program order.    The dialog box will remain on top to allow    other dates to be selected and viewed.    
When the search has been completed, [Click] the [OK] button to return to the main screen or [Double-
Click] a line to move to that program and close the dialog box.



Getting Started

Using The Songbook Database

The Songbook Database Area    at the bottom of the Program Master screen contains a list of song titles 
that can be used for any program. These titles, and numbers, are listed in the scroll    box on the left side 
of the songbook database area.    Scroll through the list box using the scroll buttons, or enter the number 
of a song in the Find # box to jump directly to that song.

This area shows the Title, Number and last four dates that the song was performed for the selected title in 
the scroll box.    To show further information for a particular song, [Right-Click] the song in the scroll box 
and the Quick Browser box will appear.    You can edit the Memo field from this box. 

The songs may be Sorted    by almost any field.    You may Search    for a particular word or phrase in any 
field as well.    This area was designed to provide you with an easy, yet powerful way, to sort, search, find, 
list, and use the songs in the songbook.

Furthermore, a personal note or memo may be entered for each song in the database.    This gives you 
another degree of customization.    As well as being a good place for notes, the memo field may also be 
used for searching and sorting, allowing a user-defined category or subject to be implemented.    For 
example, you can use a memo that distinguishes choruses, or offertories, etc.    Also, a custom rating 
system may be used, with the same    default ratings that are in the music library.    Ratings may be 
modified, as well as memos, from the Songbook Browser or the Quick Browser.

You may select the songbook version to be viewed using the Songbook menu item.    In this menu, the 
bottom entries will show available songbooks.    The songbook database shows only the currently 
selected songbook. 



Songbook Database Area

The Songbook Database area is used to select the songs for any program order in Program Master.

This area displays ALL titles in the songbook, or only titles according to the last sort or search performed 
on the Title Database.    For more information on sorting and searching, read the Sort Songbook    and 
Search Songbook topics.    To list all songs, [Click] the List ALL Titles button on the toolbar.    The 
songbook version that is currently in use is shown above the titles list box.

To select a specific song, [Click] the scroll buttons beside the song list box.    As a new song is selected, 
the last 4 dates that the song was used are displayed in the text boxes to the right of the Songbook 
Database Area.

You may enter a specific comment, topic, or note for a particular song by [Right-Clicking] over the song 
title in the Songbook Database Area.    This will bring up the Quick Browser box where the memo field and 
rating field may be edited.    This box will also contain all pertinent information regarding that song. 



Sort Songbook

To specify the order in which the songs should be sorted in the song scroll box at the bottom of the screen 
in Program Master, select the Sort by... item in the Songbook    menu, or [Click] the Sort Songbook button 
in the ToolBar. 

Select the field to use as the sort field using the drop down list.    You can also determine the order in 
which Program Master sorts by using the Ascending/Descending radio buttons.    [Click] [OK] to change 
the sort order of the songs and compile the new list.

This sort will be maintained for all future searches, until another sort is performed.



Search Songbook

To narrow the list of songs found in the Songbook Database Area, select the Search Current Songbook 
for... item in the Songbook    menu, or [Click] the Search Songbook button in the ToolBar. 

Enter the text to search for in the appropriate text boxes.    To the right of the text boxes, there are 2 drop 
down boxes containing field names, as well as a drop down list for the topics list.    You can initiate very 
simple or very complex searches from this dialog box.    Using the logical operators, And/Or at the bottom 
of the dialog box, you can narrow your search considerably.    For example, you can type "Love"    in the 
first text box and select Title in the corresponding drop down list.    You can then type a Key (i.e. "Ab" etc.) 
in the next text box, and select Key in the corresponding drop down list.    You can then select the "And" 
button, and Program Master will pull up every song with "Love" in the title, and in the key of Ab.    Capital 
letters will be ignored, so typing text in either upper or lowercase will work.

You can also use the "Or" button to create more complex searching.    For example, you could type the 
word "Love" in two text boxes, select title in one drop down list and topic in another, and select "Or" as the 
logical operator.    This search would reveal all songs that had the word "Love" in both their title and topic. 
Many variations of these examples can be done to create specific searches to fit your needs.    You will 
find that you can find virtually any record by utilizing this searching box.    Practice searching for different 
things so you become very familiar with this process. 

The Subjects list box is loaded with a list of all valid subjects for the current songbook.    [Click] on the 
Subjects list box to drop down a list of subjects to choose from.    When all search criteria has been 
entered, [Click] on [OK] to search the database and display any matching songs in the list box at the 
bottom of the screen.

Note:    Keys should be entered in the following format.    Ab for A flat major, C for C major, c min for c 
minor, etc.



Program Master Edit Menu

Cut Program:
Cuts the currently displayed program order.    Unlike the Delete Program menu item, you can later paste 
the cut program on another date using the Paste Program menu item.

Copy Program:
Copies the currently displayed program order to the clipboard.    You may then paste the program on 
another day using the Paste Program menu item, or may paste the text into their favorite word processor 
for professional bulletin formatting. 

Paste Program:
Pastes the contents of a program order that has been cut or copied on a new day.

Delete Program:
Deletes the currently displayed program out of the database.    Once a program is deleted, it cannot be 
undeleted.    You should only use this option if he/she is certain that the program order is no longer 
needed.

Export to Write.exe:
Exports the text of the currently displayed program order to Microsoft's Windows Write.    From there the 
program order may be customized and printed. 

Clear Date Used:
Clears the highlighted date used for the selected song.

Goto Program...:
Displays a sub-menu containing: Oldest, Previous, Next, Newest.    You can use these menu items to 
work through the entire database of program records.    Note:    Another way to browse the entire database 
is to use the Program Order Browser. 

Search Programs:
Brings up the Search Program Orders dialog box.    This box is used to search for specific text found in 
any program on any day. 

Search Current Songbook:
Brings up the Search Songbook dialog box.    This box can be used to search for specific text found in the 
songbook database.    For example, search for all songs with the topic "Assurance," that are in the key of 
F major, and are arranged by Tom Fettke. 

Search Multiple Songbooks...
First, this brings up the Search Multiple Songbooks list dialog box.    Select the desired songbooks to 
search from this box.    Then, the Search Songbook dialog box will be displayed.    This box can be used to 
search for specific text found in the songbook database.    For example, search for all songs with the topic 
"Assurance," that are in the key of F major, and are arranged by Tom Fettke.    After starting the search, 
the results of the search will be displayed in the Songbook Browser dialog box.    The songs found will be 
listed grouped by Songbook.    Click on a title in the list to display information about the song, including 
the songbook it is in.    The list of songs from a Multiple Songbook Search is only available in the 
Songbook Browser, when you return to the main screen, the    previous songbook will be available in the 
Songbook Database area.

Search for Dates Used...
Brings up the Date Search dialog box.    You can search for specific text, in specific fields, between 2 
dates that you specify for very narrow searching capabilities.    For example, you can search the title field 
for the text "God."    You can then specify 2 dates to search between.    The results will be every Program 
Order with the text "God" in the title that is saved between the dates that you specified. 



Sort Songbook:
Brings up the Sort Songbook dialog box.    This dialog box is used to sort the songbook. 



Program Master Calendar Menu

Previous Year :
Moves the calendar year back one year and re-displays the calendar with the new year.    The month and 
day will remain the same.

Previous Month:
Moves the calendar month back one month and re-displays the calendar with the new month.    The year 
and day will remain the same.

Today:
Moves the calendar to today's date.    Today's date is defined as the current system date on the computer, 
so for this command to work properly, the computer's internal clock/calendar must be correct.

Next Month:
Moves the calendar month forward one month and re-displays the calendar with the new month.    The 
year and day will remain the same.

Next Year:
Moves the calendar year forward one year and re-displays the calendar with the new year.    The month 
and day will remain the same.

Jump to Date...:
Brings up the Jump to Month/Day/Year    dialog box for quick jumps to a specific month, day, and year.    
The command is also available by double [Clicking] on the panel above the calendar with the current 
month and year displayed on it.



Program Master Songbook Menu

Besides the menu items listed below, this menu also includes a list of songbooks that you have loaded at 
any given time.    This list can be edited by choosing the File Menu, selecting the Preferences menu item, 
and [Clicking] on the Songbook Tab.

Browse Songbook: 
Launches the Songbook Browser dialog box producing a list of songs.    The list is determined by the 
results of a specific search or sort.    To see all songs contained in the songbook select List ALL Titles. 

List ALL Titles:
Lists all songbooks in the songbook database area at the bottom of the screen.    This is useful if a search 
has previously been done, and only a few songs are listed.    This command will make sure all songs are 
available. 

Songbooks:
The list of songbooks indicates the available songbooks and songbooks.    The Music Library entry allows 
the music library to be used as a song database, just like a songbook.    Dates used will be saved, and the 
library may also be browsed.    The last four songbooks are user-defined songbooks which can be entered 
and edited by the user.

Edit User Songbook:
Brings up the Edit User Songbooks dialog box.    This box is used for creating and editing each of 4 user-
defined songbooks.    Type in the appropriate information for each song or song and it is saved into your 
user songbook.    Use this to create databases of new songbooks or songbooks or any collection of songs 
desired to be used as songbook databases in Program Master.



Program Master Program Menu

Browse Programs:
Brings up the Browse List dialog box.    This box contains a list of all programs contained in the database. 
You can quickly jump from program to program by [Clicking] on the title of a program.

Add New Program:
Adds a new program to the database.    From there, you can insert the appropriate information to create a 
program order.

Add New Program with Template:
Brings up the Templates dialog box.    From there, you can choose one of 4 pre-defined templates to use 
in the program order.

Move Previous on this Date:
Moves to the previous record located on the same day.

Move Next on this Date:
Moves to the next record located on the same day.

Move Line Up:
Moves a selected program order line up one space.

Move Line Down:
Moves a selected program order line down one space.

Insert Line: 
Inserts a line in the program order.    If you highlight a line that is blank and then selects this menu item, 
the Edit Line box is brought up.    From there, you can edit the line.    If a line that contains text is 
highlighted, and you select this menu item, and the Edit Line box is brought up, you can press [Cancel], 
and a blank line will be inserted.

Delete Line: 
Deletes a line in the program order.

Edit Line:
Brings up the Edit Line dialog box.    From there, you can edit the contents of a line in the program order.



Music Edit Menu

Copy Record to Clipboard:
Copies the current record in it's entirety to the clipboard.

Delete Current Record:
Deletes the current record from the database.

Export Record to Write:
Exports the contents of the current record to Microsoft's Windows Write.

Search for Text:
Brings up the Search Library dialog box.    From there, you can search the database for specific text using 
the logical operators "And" & "Or."

Search for Dates Between...
Brings up the Date Search dialog box.    From this dialog box you can search for records containing data 
that pertains to the date fields.    Any field that contains a date can be searched with this box.    For 
example, you can search the Personnel Library for everyone who has a birthday between January 1, and 
February 1.    Note: Dates can be entered in any of these formats: 1-1-95, 1/1/95, Jan 1, 95, January 1, 
1995 etc. 

Search for CCLI Activity:
This menu item brings up the CCLI Search dialog box.    This box is used to search for CCLI activity.    Just 
enter the dates you want to search between and School Music Master takes care of the rest.    (In order 
for this feature to work correctly, you must catalog your CCLI songs in the Music Library.    The CCLI list 
box must have a "yes" in it in each CCLI song in your library.)

Sort By:
Brings up the Sort Library box.    Choose the field that you wish to sort by in the drop down list.    You can 
also select ascending or descending to further customize your sort.



Music Record Menu

Browse List of Records:
Brings up the Browse List dialog box.    This box gives you a list of all records currently active in the 
database.    If you have done a search or sort, the Browse List will resemble the results of that search or 
sort.    To see all the records in the database at one time, choose the List All Records menu item from the 
Record menu, or [Click] on the List All Records button on the Toolbar.

List All Records:
Refreshes the list of records to include all records, and they are sorted in the default sort order.

Add New Record:
Adds a new record to the Library database. 

Move First Record:
Moves to the first record in the Library database.

Move Previous Record:
Moves to the previous record (i.e. the record immediately preceding the currently selected record).

Move Next Record:
Moves to the next record in the Library database.

Move Last Record:
Moves to the last record in the Library database.

Edit Topics:
Brings up the Edit Topics Dialog box where the topics for each record can be edited.

Edit Orchestration:
Brings up the Orchestration Details dialog box where the orchestration details can be edited.

Edit Recording Titles:
Brings up the Edit Recording Titles dialog box where the recording titles can be edited.



File Menu

Backup Data:
Brings up the Backup Data    dialog box which allows you to make a backup copy of your data into any 
directory on any available disk.    Only the data is backed up, not the entire program.    It is recommended 
that the data be backed up frequently.

Restore Data:
Brings up the Restore Data    dialog box which allows you to restore data that has been previously backed 
up.    Any existing data will be overwritten, so be sure that the backup copy is the copy that is needed.

Save:
Saves the current record.

Print Reports:
Displays the Print Reports dialog box.    This allows the user to set up custom reports for each library.    
Report printing is fully customizable, and very flexible to allow unlimited report configurations.    Default    
can also be save for the most used reports.

Print Labels:
Displays the Print Labels dialog box.    This allows the user to set up custom labels for each library.    Over 
30 types of standard Avery brand labels are already set up.    Also, two custom label types may be defined 
by the user.    Label printing already includes a standard address label for    name/address fields, but any 
other fields may be printed on any label type desired.    This command is not available in Program Master.

Preferences:
Brings up the Preferences dialog box.    You can specify preferences for most of the drop down lists in the 
program as well as other user options. 
 
Reset Screen Size to Default:
Resets the program size to 640x480 and centers the program on the screen.    The program window size 
and position are automatically saved when the program is exited.    This option allows those settings to be 
reset. 

Exit:
Exits the program.



Equipment Edit Menu

Copy Record to Clipboard:
Copies the current record in it's entirety to the clipboard.

Delete Current Record:
Deletes the current record from the database.

Export Record to Write:
Exports the contents of the current record to Microsoft's Windows Write.

Search for Text:
Brings up the Search Library dialog box.    From there, you can search the database for specific text using 
the logical operators "And", & "Or."

Search for Dates Between...
Brings up the Date Search dialog box.    From this dialog box you can search for records containing data 
that pertains to the date fields.    Any field that contains a date can be searched with this box.    Note: 
Dates can be entered in any of these formats: 1-1-95, 1/1/95, Jan 1, 95, January 1, 1995 etc. 

Sort By:
Brings up the Sort Library box.    Choose the field that you wish to sort by in the drop down list.    You can 
also select ascending or descending to further customize your sort.



Equipment Record Menu

Browse List of Records:
Brings up the Browse List dialog box.    This box gives you a list of all records currently active in the 
database.    If you have done a search or sort, the Browse List will resemble the results of that search or 
sort.    To see all the records in the database at one time, choose the List All Records menu item from the 
Record menu, or [Click] on the List All Records button on the Toolbar.

List All Records:
Refreshes the list of records to include all records, and they are sorted in the default sort order.

Add New Record:
Adds a new record to the Library database. 

Move First Record:
Moves to the first record in the Library database.

Move Previous Record:
Moves to the previous record (i.e. the record immediately preceding the currently selected record).

Move Next Record:
Moves to the next record in the Library database.

Move Last Record:
Moves to the last record in the Library database.



Library Menu

Switches between each library contained in School Music Master.    These are:

Equipment Library
Music Library
Personnel Library
Publishers Library
Program Master



Help Menu

Contents:
Brings up the School Music Master help file.    The contents screen will be displayed.

Search:
Brings up a Search box, to search for a particular topic in the help file.    You can jump to any desired topic 
during the search operation.

How to Use Help:
Brings up the Windows Help on Help file.    It describes how to use help applications.

Ordering Information:
Brings up the Ordering information topic in the help file.    From there, you can get to the Order Form.

About:
Brings up the School Music Master About box.    It gives more information about School Music Master.



Personnel Edit Menu

Copy Record to Clipboard:
Copies the current record in it's entirety to the clipboard.

Delete Current Record:
Deletes the current record from the database.

Export Record to Write:
Exports the contents of the current record to Microsoft's Windows Write.

Search for Text:
Brings up the Search Library    dialog box.    From there, you can search the database for specific text 
using the logical operators "And", & "Or."

Search for Dates Between...
Brings up the Date Search dialog box.    From this dialog box you can search for records containing data 
that pertains to the date fields. This command will search the Performance Dates and Date Joined fields. 
Note: Dates can be entered in any of these formats: 1-1-95, 1/1/95, Jan 1, 95, January 1, 1995 etc. 

Search for Absences:
Brings up the Absence Search dialog to search for dates absent in the personnel library.

Search for Birthdays:
Brings up the Birthday Search dialog to search for birthdays in the personnel library. 

Sort By:
Brings up the Sort Library box.    Choose the field that you wish to sort by in the drop down list.    You can 
also select ascending or descending to further customize your sort.

Mark Absences:
Brings up the Mark Absences dialog box.    From this box you can select members of your choir or choirs 
and mark them absent.    This information will be saved into their record.    You can later go back and 
Search for absences.

Clear Selected Absent Date:
Clears the selected absent date in the Personnel Library record.



Personnel Record Menu

Browse List of Records:
Brings up the Browse List dialog box.    This box gives you a list of all records currently active in the 
database.    If you have done a search or sort, the Browse List will resemble the results of that search or 
sort.    To see all the records in the database at one time, choose the List All Records menu item from the 
Record menu, or [Click] on the List All Records button on the Toolbar.

List All Records:
Refreshes the list of records to include all records, and they are sorted in the default sort order.

Add New Record:
Adds a new record to the Library database. 

Move First Record:
Moves to the first record in the Library database.

Move Previous Record:
Moves to the previous record (i.e. the record immediately preceding the currently selected record).

Move Next Record:
Moves to the next record in the Library database.

Move Last Record:
Moves to the last record in the Library database.



Publishers Edit Menu

Copy Record to Clipboard:
Copies the current record in it's entirety to the clipboard.

Delete Current Record:
Deletes the current record from the database.

Export Record to Write:
Exports the contents of the current record to Microsoft's Windows Write.

Search for Text:
Brings up the Search Library dialog box.    From there, you can search the database for specific text using 
the logical operators "And", & "Or."

Sort By:
Brings up the Sort Library box.    Choose the field that you wish to sort by in the drop down list.    You can 
also select ascending or descending to further customize your sort.



Publishers Record Menu

Browse List of Records:
Brings up the Browse List dialog box.    This box gives you a list of all records currently active in the 
database.    If you have done a search or sort, the Browse List will resemble the results of that search or 
sort.    To see all the records in the database at one time, choose the List All Records menu item from the 
Record menu, or [Click] on the List All Records button on the Toolbar.

List All Records:
Refreshes the list of records to include all records, and they are sorted in the default sort order.

Add New Record:
Adds a new record to the Library database. 

Move First Record:
Moves to the first record in the Library database.

Move Previous Record:
Moves to the previous record (i.e. the record immediately preceding the currently selected record).

Move Next Record:
Moves to the next record in the Library database.

Move Last Record:
Moves to the last record in the Library database.



Library Toolbar Buttons

Help tips for any button will be displayed in the status bar when the mouse is over a button in the toolbar.

Browse List: Brings up the Browse List dialog box.

Search: Brings up the Search Library dialog box.

Sort: Brings up the Sort Library dialog box where the records can be sorted.

List All Records: Lists all records in the database.    This is especially helpful after you have previously 
initiated a search or sort.    It will erase the results of your search and list all the records in the database in 
the default sort order.

Add New Record: Adds a new record to the database.

Save: Saves the current record into the database.

Delete: Deletes the current record out of the database.

Move First Record: Moves to the first record in the Library database.

Move Previous Record: Moves to the previous record (i.e. the record immediately preceding the 
currently selected record).

Move Next Record: Moves to the next record in the Library database.



Move Last Record: Moves to the last record in the Library database.

Copy Record to Clipboard: Copies the current record in it's entirety to the clipboard.

Export Record to Write: Exports the contents of the current record to Microsoft's Windows Write.

Print: Prints the default report as defined in the Print Options dialog from the File menu.    For different 
report options, use the File menu item.

Backup: Brings up the Backup Data dialog box.

Restore: Brings up the Restore Data dialog box.



Backup Data

To backup user data, both program orders and songbook data, select the Backup Data item in the File 
menu. 

First, select the desired drive in the drive list box.    Next, select the directory for the backup files in the 
directory box.    To verify the location, the drive and directory selected will be placed in the destination 
panel.    All files that have changeable data will be backed up.



Restore Data

To restore user data that has been previously backed up, select the Restore Data item in the File    menu. 

First, select the desired source drive in the drive list box.    Next, select the directory that contains the 
backed up files in the directory box.    To verify the location, the drive and directory selected will be placed 
in the source panel.    The file list box will display the files that will be restored for confirmation.    Note, 
when data is restored, the current data in the program directory will be DELETED by the new files.    Make 
sure that the data to be restored is the desired data.



Program Master ToolBar Buttons

The following descriptions explain the function of each toolbar button in Program Master.    All toolbar 
button functions have a corresponding Menu System    command that performs the same task.    Help tips 
for any button will be displayed in the status bar when the mouse is over a button in the toolbar.

Songbook Browser: This button brings up the Songbook Browser dialog box.    This box allows you to 
see all information pertaining to a specific search, or the entire songbook contents. 

Search Songbook: This button brings up the Search Songbook    dialog    box to allow you to search for a 
particular word or phrase in the title, subject, tune, meter, key, composer, author, scripture, or memo 
fields.    Only the songs that match the search criteria will be shown in the songbook database list box at 
the bottom of the screen.    Use the List ALL Titles command to refresh the list to include all titles.

List All Titles: This button refreshes the songbook database list to include all titles.

Add New Program: This button adds a new, blank program order record on the current date.    Use this 
command to add a program order to a date that already has at least one program order.

Save: This button saves the current program order record that is displayed. 

Show Previous on this Date: This button moves to the previous record on the current date if one exists. 
This command is only available if the light next to the date above the calendar is green.    If the date does 
not have a record before the current program order, the menu item and this button are disabled.

Show Next on this Date: This button moves to the next record on the current date if one exists.    This 
command is only available if the light next to the date above the calendar    is green.    If the date does not 
have a record after the current program order, the menu item and this button are disabled.

Browse List of Program Orders: This button displays the Browse List dialog box.    This box gives you a 
list of all program orders in your database.    From here, you can reach any program by [Double-Clicking] 
on the appropriate program order.



Search Program Orders: This button brings up the Search Program Orders dialog box.    It allows you to 
search for any text string within all program orders.    Once the desired search text is entered, [Click] on 
Find to locate all program orders containing the search criteria and list them in a list box.

Insert Line: This button brings up the Edit Line dialog box.    From this box, a song or custom event may 
be inserted between lines in the program order.    If you want to insert a blank line, press the [Cancel] 
button.

Move Line Up: This button moves the currently highlighted event in the program order up one line.    
[Click] on any line the program order to highlight it before using this command.

Move Line Down: This button moves the currently highlighted event in the program order down one line. 
[Click] on any line the program order to highlight it before using this command.

Delete Line: This button deletes the currently highlighted event in the program order.    [Click] on any line 
the program order to highlight it before using this command.

Edit Line: This button brings up the Edit Line dialog box.    This dialog box allows the editing of a single 
line in the program order.    [Click] on any line the program order to highlight it before using this command.

Export Program Order to Write: This button exports the current program order to the windows word 
processor, WRITE.EXE.    It may then be edited or printed as desired.

Print Program Order: This button prints a professional report of the displayed program order.      The 
report printed is the default report defined by the Print Options dialog in the File menu.    To specify 
different options, use the File menu item.



Technical Support

The highest testing has been performed on every aspect of our products, but the need for support does 
occasionally arise.    Before contacting technical support, follow the steps listed below.    Also, make sure 
you have the most current version of the program.    The latest updates, hints, tricks, and frequently asked 
questions (FAQs) are available at our World Wide Web site: 
http://www.goshen.net/cmp101/cmp.html.

Technical support is available at no charge by...

Sending electronic mail to:

CMPTek on America Online
cmptek@aol.com on the Internet

OR

Via US Mail by sending an SASE to:

CMP Tech Support
c/o Wakefield Development
749 Okieridge Road
Yukon, OK 73099 

OR

Via Fax by sending a report to 405-273-6566.

When reporting problems with the software, please include the following information:

1) What action or command was being performed when the problem occurred.
2) Is the problem reproducible?    If so, how?
3) If a dialog box with an error message was displayed, please include the full text of the message.
4) Include the date of purchase and the name under which the program is registered.
5) Include the version number from the about box.
6) Feel free to make any comments, suggestions, or possible improvements to be included in the next 
version of    the software.

Thank you.



Software License Agreement

Use
You (an organization or individual) may use one copy of the Software on one computer.    The Software is 
"in use" on a computer when it is resident in memory or installed on the hard disk.    You may make only 
one (1) backup or archival copy of the original diskettes.

Restrictions
You may not modify or alter this Software in any way, including decompiling or disassembling.    You may 
not loan, rent, lease, or license this Software or any copy of it.    You may transfer the Software only if you 
transfer the Software and all documentation and disks, and you may not retain any copy.    If the Software 
being transferred is an update or upgrade, then the transfer must include the most recent update, and any 
prior revisions (disks and documentation).

Copyright
All intellectual rights in the Software and documentation are owned by Composer's Manuscript Press & 
Wakefield Development or its sources. 

Limited Warranty
For thirty (30) days from your date of purchase, the warranty expresses that (1) the Software shall 
basically conform to the supplied documentation and (2) the media (disks) on which the Software is 
distributed    are free from major defects in workmanship and materials.    The supplier, at its option, will 
refund the amount you paid for the software (less shipping) or provide you with corrected items, if the 
defective item(s) is returned to the supplier.    These are the only options available for any warranty claim.

Except as expressly provided in this agreement, Composer's Manuscript Press makes no warranty or 
representation,    promise or guarantee, either expressed or implied, statutory or otherwise, with respect to 
this Software or user documentation, including their quality, performance, merchantability, or fitness for a 
particular purpose.

The warranty and remedies set forth in this agreement are exclusive and in lieu of all other oral, written, 
expressed, or implied agreements.    No dealer, distributor, agent or employee is authorized to make any 
modification or addition to this warranty, unless that entity accepts sole responsibility for fulfilling such an 
additional agreement.

Limitation of Liability
Because software is by nature complex and may not be totally free from errors, you are advised to verify 
your work and make backup copies of the data as necessary.    In no event will Wakefield Development or 
Composer's Manuscript Press be liable for indirect, incidental, consequential, or any other damages 
arising out of the use or of the inability to use the Software or documentation.    In no case shall the 
liability exceed the amount paid for the Software.    Some states do not allow the exclusion or limitation of 
implied warranties or limitation of liability for damages, so the above limitation may not apply to you.



Creating and Using Templates

To create a program order template, create a program order with the information that you want the 
template to contain.    Be sure to give it a title.    Pull down the file menu and select the Save As Template 
menu item.    The Templates dialog box appears.    Choose one of the 4 templates from the drop down 
box. [Click] [OK] and your template will be saved. 

To use a template, pull down the Program Menu and select the Add New with Template menu item, or 
[Click] the Add New button.    Note:    In order for the Add New Button to bring up the Templates dialog box, 
the appropriate setting must be chosen in the Program Master Preferences screen.    Choose the 
template that you want to use from the drop down menu.    [Click] [OK] and your template will be inserted 
into the current program order. 



Program Overview

School Music Master is a powerful Windows based tool for school music management, program and 
preformance planning, and songbook/chorus book referencing.    It incorporates the elements of a 
songbook cross-reference and a library database.    This program will help you manage your school music 
program more efficiently than ever before. You'll wonder how you ever got along without it. 

Included in School Music Master are 4 libraries to keep track of your music, personnel, 
publishers/dealers, and equipment.    Also included is the latest version our popular program Program 
Master.      Program Master allows you to plan multiple programs on any date with up to 80 entries from 
the songbook or other multiline custom information entered by the user.    All programs are saved for 
future reference, and the four most recent dates a song was used are continually tracked. 

Anyone involved in school music should be using School Music Master, so tell a friend about School 
Music Master today.

To make suggestions for program improvements, or for additional copies or a site license of School Music 
Master, contact Composer's Manusciprt Press:

Composer's Manuscript Press
P. O. Box 2461
Shawnee, OK    74801
Email: CMP101@aol.com
Compuserve: 71234,3211

Also, check out our World Wide Web site: http://www.goshen.net/cmp101/cmp.html for more 
information, the latest updates, tips, and other products from Composer's Manuscript Press.

License information is    contained later in the help file.



Quick Browser

The Quick Browser dialog box is used for quick reference of songs.    It contains the same information 
found in the Songbook Browser dialog box: number, title, tune, key, meter, topic, scripture reference, 
composer, arranger, author, rating and user-defined memo for each song.    The difference between the 
Quick Browser and the Songbook Browser is the Quick Browser is not a list.    It is merely a quick 
reference to the appropriate information for a specific song.    The Songbook Browser is used for browsing 
the entire songbook in a list form. 

The Quick Browser can be launched by either [Right-Clicking]    the mouse while holding the cursor over 
the Available Songs Box at the bottom of the screen, or by selecting a line in the program order that 
contains a song and [Right-Clicking] the line.    Be sure that you highlight a line in the program order 
before [Right-Clicking] or the Quick Browser will appear with the information pertaining to the song in the 
Available Songs Box, and not the song in the program order. 

Memo
This field can be used to make special notes about a song.    You can also use this field to categorize your 
songs.    For example, you can put the word "Chorus" in the memo field of all choruses in the songbook.    
You can then search the songbook specifying the memo field as the search denominator.    All the songs 
with your memo will appear. 

Rating
This field is the same rating field that is used in the music library.    It can contain any system of rating that 
you wish to have.    To edit this field, choose the Preferences menu item from the File menu and select the 
Music Tab.    Select the Rating option and type in the rating system that you would like to use. 



Songbook Browser

The Songbook Browser dialog box contains a list of all the information that has been requested for a 
specific song or songs.    The Songbook Browser can contain a list of all the songs in the songbook, or 
merely the results of a songbook search or sort.    The information contained in the Songbook Browser 
includes: songbook, number, title, tune, key, meter, scripture reference, composer, arranger, author, 
rating, and user-defined memo. 

The Songbook Browser can be accessed in several ways.    The most basic way is by pulling down the 
Songbook Menu and select the Songbook Browser menu item, or [Clicking] on the Songbook Browser 
icon on the toolbar.    Also, the Songbook Browser can be accessed by [Clicking] the "Open Browse List 
with Results of Search" checkbox in the Search Songbook dialog box.    After a search has been done, the 
results will automatically be displayed in the Songbook Browser dialog box. 

Memo
This field can be used to make special notes about a song.    You can also use this field to categorize your 
songs.    For example, you can put the word "Chorus" in the memo field of all choruses in the songbook.    
You can then search the songbook specifying the memo field as the search denominator.    All the songs 
with your memo will appear. 

Rating
This field is the same rating field that is used in the music library.    It can contain any system of rating that 
you wish to have.    To edit this field, choose the Preferences menu item from the File menu and select the 
Music Tab.    Scroll over to the Rating section and type in the rating system that you would like to use. 

Buttons:
Close: This button will close the Songbook Browser dialog and return to the main screen.
Insert in Program: This button will insert the selected title into the current program order in the hilighted 
position.
List All: This button will refresh the list of songs to include all songs in the database and 
reload the Songbook Browser.

Clipboard: This button will copy the list of titles to the clipboard for export to other windows 
programs.
Write: This button will copy the list of titles to windows write.exe for further manipulation or 
printing.
Printer: This button will print the list of titles to the default printer for quick output.



Music Field Descriptions

Title
Use this field to enter the title of your song, arrangement, piece, trax etc.

Composer
Use this field to enter the name of the composer for each piece.    Enter these names last, first if you 
would like to sort by last name in this field.

Arranger
Use this field to enter the name of the arranger for each piece.    Enter these names last, first if you would 
like to sort by last name in this field.

Author
Use this field to enter the name of the author of the text of each piece.    Enter these names last, first if 
you would like to sort by last name in this field.

Scripture
Use this field to enter the scripture reference that pertains to each library record.

Topics
[Click] in the Topics field to bring up the Edit Topics dialog box.    You can enter up to 16 topics relating to 
your library record. 

Memo
Use this field to enter any text pertaining to your record.    You may want to add additional information like 
tempo etc. 

Dates Used
Use these for fields to keep track of the dates that a piece was used.    If you use your music library in 
conjunction with Program Master, these date fields will be automatically updated. 

Checked Out to
Use this field to keep track of who a piece is loaned out to.    Use the Out Date and Due Date fields for 
keeping track of when the material was loaned out, and when it is due back.    Enter these names last, 
first if you would like to sort by last name in this field.

Out Date/Due Date
Use theses fields to keep track of when the material was loaned out, and when it is due back.

Source
Use this field to track the name of the publisher or dealer that you purchased the record item from. 

Date Purchased
Use this field to keep track of the date that the record item was purchased.

# of copies
Use this field to track the number of copies that were purchased.

$ per copy
Use this field to track the price per copy that was paid.

Library Number
Use this field to keep track of your churches library number if one applies for the record item.    To sort 
library number properly, if you need to enter number such as 18 or 4, make sure all numbers have the 
same number of digits.    For example, enter numbers in the form... 0008, 0018, 0099, 0123, 4567, etc. 



otherwise "8" will be sorted before "400".

Catalog Number
Use this field to keep track of the publisher's catalog number for each piece if one applies.
 
Choir
Use this drop down list to keep track of the choir for which the record item applies.    You can customize 
this menu by    selecting the File menu, selecting preferences, and choosing the Music Tab.    If you would 
like to enter    text that is not one of the 10 defaults, just type it into the combo box.    This will work for any 
of the combo boxes.

Key
Use this field to keep track of the key signature that applies for the record item.

Voicing
Use this pull down list to keep track of the voicing for the record item if it applies.    As with all drop down 
lists in this library, you can customize this menu by pulling down the File menu, selecting preferences, and 
choosing the Music Tab.    If you would like to enter    text that is not one of the 10 defaults, just type it into 
the combo box.    This will work for any of the combo boxes.

Accompaniment
Use this drop down list to keep track of the accompaniment requirements for each record item.    As with 
all drop down lists in this library, you can customize this menu by pulling down the File menu, selecting 
preferences, and choosing the Music Tab.    If you would like to enter    text that is not one of the 10 
defaults, just type it into the combo box.    This will work for any of the combo boxes.

Orchestration
The orchestration button and field are used to keep specific details of your orchestral needs for a specific 
piece.    The drop down box can be used to reflect the general nature of the orchestral needs, while the 
Orchestration Dialog box can be used for more specific notes.    For example, the drop down list may say 
Brass.    When you [Click] on the Orchestration button you can keep track of detailed information like the 
number of trumpets, horns, and trombones etc.    The instruments appear grayed out at first.    [Click] 
anywhere on the instrument text and it lights up.    You can then enter a number in the white text box to 
the right of the instrument text.    You can keep track of how many instruments are required for each 
library record. 

Type
Use this drop down list to categorize your library.    This might say octavo, or recording, or video, or a 
whole number of other things.    By using this drop down list in conjunction with the other fields in this 
library, you can create    multiple libraries within the Music Library.    You could catalog your midi files, or 
your tapes, or trax, etc.    As with all drop down lists in this library, you can customize this menu by pulling 
down the File menu, selecting preferences, and choosing the Music Tab.      If you would like to enter    text 
that is not one of the 10 defaults, just type it into the combo box.    This will work for any of the combo 
boxes.

Titles:    This field is used in addition to the type of record that you are creating.      This can be an octavo, 
recording, video, track, etc.    In the case of a video or recording, [Click] on the Titles button next to the 
Type field and enter up to 16 titles for that recording.    That information will be automatically saved with 
that record.

CCLI
Use this drop down list to specify whether or not a piece is licensed under CCLI.    By marking a piece 
"Yes," you can later choose the Search for CCLI Activity menu item to bring up reports of how many CCLI 
songs you have used during a specified period of time. 

Difficulty



Use this drop down list to rate each record item according to difficulty.    You may enter simple, moderate, 
hard, or your own personal scheme.    As with all drop down lists in this library, you can customize this 
menu by pulling down the File menu, selecting preferences, and choosing the Music Tab.    If you would 
like to enter    text that is not one of the 10 defaults, just type it into the combo box.    This will work for any 
of the combo boxes.

Rating
Use this drop down list to provide a rating system for your record item.    As a default, the educational 
rating system of A through F is entered.    You can of course change this to match your specific needs.    
As with all drop down lists in this library, you can customize this menu by pulling down the File menu, 
selecting preferences, and choosing the Music Tab.    If you would like to enter    text that is not one of the 
10 defaults, just type it into the combo box.    This will work for any of the combo boxes.

Midi/Run & Text/Run
The Midi/Run & Text/Run buttons are used to attach files to a specific library record.    [Clicking] on either 
the Midi or Text buttons will bring up a dialog box that will allow you to search for a Midi or Text file.    The 
Run buttons will launch a file once a file has been attached to your library record.    These buttons can be 
very helpful in keeping track of Midi files and text files.    For example,    you have a midi file of a specific 
arrangement that you use.    By attaching the midi file to the record, you can easily hear the arrangement 
using the standard Windows Media Player.    The same goes for a text file.    Let's say that you want to 
keep track of the text to a song or chorus.    Just use your favorite word processor, write.exe, or 
notepad.exe, to create the text file, and then attach it to a music library record.    Simply [Click] on the 
Run button and presto, there is your text. 

These buttons can actually be used to attach any file to a record.    When you [Click] on the run button, 
School Music Master will go out and find the program that is associated with your file, and launch it with 
your    file.    Just make sure that the extension of your file is listed in the Extensions section of your 
win.ini file.    In most cases, this will already be done for you.    Only advanced Windows users should 
consider altering their win.ini file.    If you are not sure how to do this, please consult an expert. 



Equipment Field Descriptions

Item
Use this field to indicate what item is being tracked.    It could be something like timpani, choir robe, drama 
set, etc. 

Description
Use this field to give a detailed description of the record item.

Manufacturer
Use this field to keep track of the manufacturer of the record item.

Model
Use this field to keep track of the model of the record item.

Serial Number
Use this field to keep track of the serial number of the record item.

Memo
Use this field to enter any other information that you require for your library record.

Checked Out to
Use this field to keep track of who a record item is loaned out to.    Use the Out Date and Due Date fields 
for keeping track of when the item was loaned out, and when it is due back.    If you would like to sort the 
names by last name, enter the data last, first into this field.

Out Date/Due Date
Use these fields to keep track of when the item was loaned out, and when it is due back.

Source
Use this field to track the name of the publisher or dealer that you purchased the record item from. 

Date Purchased
Use this field to keep track of the date that the record item was purchased.

Quantity
Use this field to track the number of items that were purchased.

Price Each
Use this field to track the price that was paid per item.

Inventory Number
Use this field to enter your inventory number specific to your library.

Catalog Number
Use this field to track the manufacturer's catalog number.
 
Category
Use this drop down list to categorize your items.    This list may reflect, instruments, drama equipment etc. 
As with all drop down lists in this library, you can customize this menu by pulling down the File menu, 
selecting preferences, and choosing the Equipment Tab.    If you would like to enter    text that is not one of 
the 10 defaults, just type it into the combo box.    This will work for any of the combo boxes.



Personnel Field Descriptions

First/Last Name
Use these fields to track the first and last name of each person in the personnel library.

Address
Use this field to keep track of the address of a person in the personnel library.

City/State/Zip
Use these fields to track the city, state, and zip code of a person in the personnel library.

Home Phone
Use this field to keep track of the home phone number of a person in the personnel library.

Work Phone
Use this field to keep track of the work phone number of a person in the personnel library.

Fax
Use this field to keep track of the fax number of a person in the personnel library.

Other
Use this field to keep track of any extra phone numbers such as a pager. 

Birthday
Use this field to keep track of the birthday of a person in the personnel library.    Later, you can use the    
Birthday Search dialog box to search for everyone with a birthdate between 2 specified dates.

Occupation
Use this field to keep track of the occupation of a person in the personnel library.

Memo
Use this field to keep track of any extra information pertaining to a person in the personnel library.    This 
field may include an e-mail address as well as a work address.

Solo/Ensemble Performances
Use these fields to keep track of when someone sang a solo or participated in an ensemble performance. 
Later, you can use the Search for Dates Between dialog box to search for everyone sang a solo on or 
between 2 specified dates.

Choir
Use this drop down list to specify which choir a person joined.    This list may include specific names of 
choirs, or just a generic name like Adult 1 etc.    As with all drop down lists in this library, you can 
customize this menu by pulling down the File menu, selecting preferences, and choosing the Personnel 
Tab.    If you would like to enter    text that is not one of the 10 defaults, just type it into the combo box.    
This will work for any of the combo boxes.

Date Joined
Use this field to keep track of the date that a choir member joined the group.    Later, you can use the 
Search for Dates Between dialog box to search for everyone who joined a specific choir on or between 2 
specified dates.

Parts
Use this drop down list to specify what part a person sings.    As with all drop down lists in this library, you 
can customize this menu by pulling down the File menu, selecting preferences, and choosing the 
Personnel Tab.    If you would like to enter    text that is not one of the 10 defaults, just type it into the 
combo box.    This will work for any of the combo boxes.



Position
Use this drop down list to specify what position someone holds in the choir or music program.    This field 
can include president, treasurer, sound man, janitor, etc.    As with all drop down lists in this library, you 
can customize this menu by pulling down the File menu, selecting preferences, and choosing the 
Personnel Tab.    If you would like to enter    text that is not one of the 10 defaults, just type it into the 
combo box.    This will work for any of the combo boxes.

Folder #
Use this field to specify a folder number for someone in the Personnel Library.

Robe # 
Use this field to specify a robe number for someone in the Personnel Library.

Instruments Played
Use this field to specify any instruments played by someone in the Personnel Library.

Dates Absent
This field will be updated automatically when you mark absences for your rehearsals.    To mark 
absences, choose the mark absences menu item in the Edit menu.    Select the choir that you are 
calculating for, and highlight the names of everyone who was absent when the list pops out to the right of 
the dialog box.    Each person's record will be updated with the date of the absence.    Later, you can use 
the Search for Absences dialog box to find everyone who has been absent for more than a number of 
days that you specify.    You can also use the Search for Dates Between dialog box to locate everyone 
who was absent between 2 dates that you specify. 



Publishers Field Descriptions

Company
Use this field to keep track of the company name that you are dealing with.

Address 1
Use this field to enter the first line of the address of the company that you are dealing with.

Address 2
Use this field to enter the second line of the address of the company that you are dealing with.

City/State/Zip
Use these fields to enter the city, state, and zip code of the company that you are dealing with.

Contact: First/Last Name
Use this field to keep track of the first and last name of the contact that you may have at a specific 
company.

Product/Program
Use this field to keep track of the product or program that a company provides.

Memo
Use this field to enter miscellaneous data pertaining to a library record.

Phone Number
Use this field for the phone number of a company or contact.

Fax Number
Use this field for the fax number of a company or contact.

Other Number
Use this field for any other number of a company or contact.

Discount
Use this field to note any discount that you may receive from a particular publisher or dealer. 



Credits

Concept & Design:    Scott D. Oyer
Programming:    Shawn Wakefield
Beta Testing Director: Ryan Hitchcock

We would like to send a special word of thanks to all those who bought earlier versions of our software.    
It was you that gave us the incentive to keep plugging along with this dream.    The hours have been long 
and hard, but we have finally arrived at a great piece of software.    It is our intention to contribute to music 
education by providing this product that will assist those of you who are knee deep in the music education 
field.    If you have suggestions, please send them our way.    It is the only way that we can continue to 
better our product.    We welcome feedback from our customers with open arms so please send us your 
suggestions. We hope that this product will make you more organized and productive so you can 
concentrate on the more personal side of your instruction.    Thank You!



Personnel Library

All of the library screens are easy to use.    Just fill in the blanks to complete your record.        The 
Personnel Library allows the user to catalog choir members, musicians, other music group members.      
Look at the field descriptions topic for more details.

Menu Commands:
File
Edit
Record
Library
Help

Field Descriptions

Toolbar Buttons
Status Bar



Publishers Library

All of the library screens are easy to use.    Just fill in the blanks to complete your record.    The 
Publisher/Dealer Library is used to keep information on the publishers or dealers that you use.    We have 
taken the liberty of including 50 of the most popular publishers for you.      Delete the names that you do 
not wish to keep.

Menu Commands:
File
Edit
Record
Library
Help

Field Descriptions

Toolbar Buttons
Status Bar



Program Master

Menu Commands:
File
Edit
Calendar
Songbook
Program
Library
Help

Toolbar Buttons

Screen Areas:
Calendar Area
Program Order Area
Songbook Database Area
Status Bar



School Music Master Order Form

Use this order form to order a full, licensed version of School Music Master, or any of our other products. 
To print this order form choose the Print Topic item from the File Menu in help.    Please, fill in all 
information, and mail a check or money order to:

Composer's Manuscript Press
P.O. Box 2461
Shawnee, OK 74801

School Music Master (for schools & universities)              (Qty) ______ at $129 = ______
($129 Special Introductory Price, Regularly $189)

School Music Master Site License              (Qty) ______ at $89 = ______
(for 2 or more copies used at one site - 2 copy minimum)

Church Music Master (for church music programs)      (Qty) ______ at $149 = ______
(The COMPLETE church music software)
($149 Special Sale Price, Regularly $189)

Subtotal        = ______

OK residents only - add 7.5% Sales Tax if applicable        = ______
Shipping and Handling          $5      (per copy) = 

______
 International Orders            $15 (additional per order) = ______

C.O.D. if applicable          $5      (additional per order) = ______
          (Sorry, no international COD orders)

ORDER TOTAL = ______

Name: _____________________________________        Date:___________

Organization: ________________________________

Address: ____________________________________________

City, State, Zip: _______________________________________

Phone: _________________            Fax:_________________

Electronic Mail address: ____________________________

How did you hear about Composer's Manuscript Press?

Comments?



Ordering Information

Pricing:
School Music Master (for schools and universities) Item # 14048 - $129
($129 Special Introductory Price, Regularly $189)

(For School Music Master Site License pricing, see the order form.) 

Church Music Master    (for church music programs, includes Hymal Master) Item # 11867 - $149 
($149 Special Sale Price, Regularly $189)

All orders add $5.00 S&H.    COD orders add an additional $5.    OK residents add 7.5% sales tax unless 
you are tax exempt as churches are.    International orders add an additional $15 per order.    No 
international COD oders.

Credit Card Orders:
To order by Credit Card, (Visa, MC, Discover, Amex) contact the Public Software Library toll free at 1-800-
242-4PsL (1-800-242-4775) from 7 AM to 6 PM Mon - Thu and 7 AM - 12:30 PM Fri (CST). 

PsL can also be contacted 24 hours a day, 7 days a week:
By Fax - (713)-524-6398
By E-mail at 71344.470@compuserve.com.
  
Or send U.S. mail to PsL, P.O. Box 35705, Houston, TX 77235-5705. 

Remember, this is for Credit Card orders only.    All other methods of payment should be done directly 
through Composer's Manuscript Press.    Please do not contact PsL for any other reason other than Credit 
Card orders.    They cannot answer any questions about the software.

Check or M/O Orders:
Send the order form with Check or M/O to:

Composer's Manuscript Press
P.O. Box 2461
Shawnee, OK 74801

COD Orders:
To order by C.O.D. send the order form to the above address, Fax the order form to us at 405-273-6566, 
or e-mail us at CMP101@aol.com or 71234.3211@compuserve.com. 

C.O.D. orders must add an additional $5.00.    Sorry, no international COD orders.

Site Licenses:
A site license for School Music Master entitles the organization to one copy of the distribution package.    
The organization may then duplicate the diskettes for the specified number of copies purchased.



Browse List

The Browse List dialog box is used to show a list of records in the libraries, and also to show a list of 
program orders from Program Master.

The Browse List dialog box is accessed by [Clicking] on the Browse List Button on the tool bar, or by 
choosing the Browse List of Records menu item in the Record Menu.    This will display a list of all 
currently available records.    The Browse List dialog box is also used to display the results of the current 
search if desired.      For some searches, the Browse List is the only way to display the results of a special 
search, these include birthday, absence, and program order searches, and in these cases, the Browse 
List will be opened automatically after the search.

If you [Double Click] on a record in the record list, the corresponding record is displayed on the main 
screen.    You may select a record to go to, then select the OK button to close the list and display the 
selected record.    The contents of the Browse List will not change until another search or sort are 
performed, or until the List All command is used.

Buttons:
OK: This button closes the Browse List dialog.
List All: This button to display    all records of a library in the default sort order.

Clipboard: This button copies the contents of the Browse List list box to the clipboard for use in other 
windows applications.

Write: This button copies the contents of the Browse List list box to Windows write.exe for further 
manipulation or printing.

Printer: This button sends a copy of the Browse List list box to the current printer for a quick printed 
output copy.

Labels: This button prints a copy of each record listed in the Browse List list box to a label.    The 
labels used are the default label settings from the Label Options dialog in the File menu.    
Whatever label type, fields, alignments, etc. are used to print a set of labels.    This could be 
especially useful to print labels for things such as absence searches in the Personnel Library 
to send reminder cards to people who have been absent.



Mark Absences

The Mark Absences dialog box is accessed by selecting the Mark Absences menu item in the Edit menu 
of the Personnel Library.    It is used to mark absences of your choir personnel.    When the box appears, 
the current date is displayed in the date box. 

You can mark absences for all choirs or by selected choirs one at a time.    Choose the appropriate radio 
button to specify the action desired.    [Click] [OK] and the box is expanded with the names of the 
personnel in the choir that you chose.    If all choirs is selected, everyone in the personnel library is 
represented.    If for example, adult choir is selected, the personnel of the adult choir will be listed.    [Click] 
on each persons name that was absent and then [Click] [Mark Selected Names Absent].    The box 
disappears and the absences are marked.    To clear an absent date from a personnel record, see Clear 
Selected Absent Date in the Edit menu.



Absence Search

The Absence Search dialog box is accessed by selecting the Search for Absences menu item in the Edit 
menu of the Personnel Library.    It is used to search for the names of people who were absent on or 
between two specific dates.    The dates and the amount of absences can be specified.    (For example, 
you can search for all personnel who were absent 2 times between January 1 and February 10.)

To search, do the following:

1. Specify the choir to search in the Choir Selection area drop down list, or select all choirs to search all of 
your choirs.
2. Specify the number of absences and the dates to search between in the search criteria area. 

When the search is completed the Browse List dialog is displayed to show the results of the search, if any 
names were found. You can jump directly to their personnel record by [Clicking] on their name in the list. 



Date Search

The Date Search dialog box is accessed by selecting the Search for Dates Between menu item in the Edit 
menu of the Personnel Library.    It is used to search for records with specific information pertaining to 
specific dates.    For example,    you can search for all personnel who joined the choir between two dates, 
whose name is Bob.

1. Determine the text to be searched for by selecting the Selected Record radio button in the Select 
Records to Search area of the dialog box.

2. Type the text to be searched for in the Search for Text area, and select the field to search in from the 
drop down list.

3. Specify the date field to be searched and the dates to be searched between in the Search Date Criteria 
area of the dialog box.

4. Check the Open Browse Box with List of Results check box.

5. [Click] [OK]



Edit Topics

The Edit Topics dialog box is accessed by selecting the Edit User Songbook Menu item from the 
Songbook menu of Program Master, then [Clicking] in the Topics area of the Edit User Songbook dialog 
box.    It is also accessed by selecting the Edit Topics menu item from the Record menu of the Music 
Library, or by [Clicking] in the topics area of the Music Library.    It is used to edit the Topics for each song 
in a User-defined Songbook or each entry into the Music Library.

The box has 16 separate fields that can be filled with the text of your choice.    Appropriate topics include, 
Thanksgiving, Praise, Jesus Christ etc.    These topics can later be searched from the Text Search dialog 
box.



Edit Recording Titles

The Edit Recording Titles dialog box is accessed by selecting the Edit Recording Titles menu item from 
the Record menu of the Music Library or by [Clicking] in the Titles button next to the Type drop down list in 
the Music Library.    It is used to specify the titles of recordings or videos in the Music Library.    The box 
has 16 separate fields that can be filled with the text of your choice.



Orchestration Details

The Orchestration Details dialog box is accessed by selecting the Edit Orchestration menu item from the 
Record menu of the Music Library, or by [Clicking] the Orchestration button in the same library.    It is used 
to specify the instruments required by a specific piece.

There is a checkbox for conductor and choir which can be used to determine if the pieces requires either. 
The rest of the box contains a list of instruments that appear gray.    [Click] on the instrument to be used 
and type the number of those instruments required in the text box to the right of the instrument name.    
After selecting all of your instruments, [Click] [OK] and the information is automatically saved with that 
record.    We have grayed the unused instruments to make the details easier to read at a glance.



Preferences

The Preferences dialog box is accessed by selecting the Preferences menu item in the File menu.    It is 
used to determine the many user preferences for the program.    There are 5 tabs with preferences on 
each tab representing General, Program Master, Equipment, Music and Personnel.    Please note, many 
of these preferences will not take effect until the program is restarted.

General
Program Master
Equipment
Music
Personnel



General Preferences

Confirmations:
This section is used to set the confirmations for exiting the program and delete operations. Deselecting 
the Confirm Program Exit checkbox allows you to exit the program without being asked if you want to 
leave.    Deselecting the Delete Operations checkbox allows you to perform delete operations without 
being asked to confirm them.

Backup Options:
This section is used to set backup options that will prompt you to do a backup every time you exit the 
program.    You can also set the default backup directory to which you want to backup your files.    Choose 
the Browse button to browse for a default backup directory.    By selecting the Prompt for Backup on Exit 
checkbox, you will be prompted to backup your files every time you exit the program.    If you do not wish 
to backup your files, [Clicking] [Cancel] will immediately exit the program.

Toolbar Print Function:
This section is used to select what function the toolbar print button will perform.    Print Program or 
Detailed Report will cause the print button to automatically send a copy to the printer based on the saved 
default settings.    The Display Print Reports Dialog Box will cause the print button to display the Print 
Reports box to allow the user to select specific print options before printing.

Database Location:
This section is used to select    where the user would like to store the data files.    It allows another drive or 
directory to contain the data files.    After changing this setting, the user will be prompted to move the 
database files to the new location immediately.    If they are not moved automatically, the user will need to 
manually copy the files to the new directory.    This option allows network users to store the data files in a 
common location for all users to access.

Please note, many of these preferences will not take effect until the program is restarted.



Program Master Preferences

This screen is used to set the preferences for the Program Master.    Please note, many of these 
preferences will not take effect until the program is restarted.

Songbook Menu Choices:
This area is used to determine which songbooks will appear in the Songbook menu in Program Master.    
If you would like to shorten your Songbook menu, deselect the checkbox next to the songbooks you want 
to leave out of the menu.

User Songbook Titles:
This section is used to determine the titles for the user-defined songbooks that will appear in the 
songbook menu.    You can have up to four user-defined songbooks.

Template to Use on Add New: 
This section is used to determine what template prompt, if any, will be shown when [Clicking] on the Add 
New button.

None:    This will give no prompt when the Add New button is pressed.

Prompt When Adding:    This selection will bring up the Templates dialog box to prompt you to choose a 
template before proceeding.

Templates 1, 2, & 3:    These are used to automatically insert the corresponding template into the current 
program order.

Daily Schedule:    This selection will automatically insert the Daily Schedule template in the current 
program order.

Default Song Field:
Use this list box to select the default song field for automatic entry into the comment column.    Many 
churches put the song tune at the right column in a program order, and this option allows the user to 
decide what field should be used automatically.

Songbook Browse Warning:
This checkbox is used to disable the warning when loading the Songbook Browser dialog box.

Grid Font Checkbox: 
This checkbox is used to determine whether the font in the grid is bold or normal.



Equipment Preferences

This screen is used to set the preferences for the Equipment Library.    Please note, many of these 
preferences will not take effect until the program is restarted.

Categories: 
This list of text boxes can be customized to fit your own particular needs.    You can determine what 
appears in the Categories drop down list in the Equipment Library.    There are 10 fields for you to 
customize.    Appropriate categories may be: Instruments, Drama, Costumes, Robes, etc.

Default Sort Order:
This section is used to determine the default sorting order of the Equipment library.    Choose either item 
of inventory number from the drop down list.



Music Preferences

This screen is used to set the preferences for the Music Library.    Please note, many of these preferences 
will not take effect until the program is restarted.

Modify: 
These radio buttons correspond to the ten text boxes to the right.    These text boxes can be customized 
to fit your own particular needs.    You can determine what appears in the various drop down lists in the 
Music Library by customizing these boxes.    To do this:

1.    Choose a radio button that corresponds to the drop down list you wish to modify.    (i.e. choir, rating, 
type, etc.)
2.    Fill in the text boxes to the right.
3. Choose another radio button and continue until all lists are customized.
4. [Click] [OK]

Default Directories: 
This section is used to specify the default directories for text and MIDI file attachments in the music 
library.    Type in the full path of the directory that the various files are stored.    We recommend creating 
special directories for your MIDI and Text files although it is not necessary.

Default Sort Order: 
This section is used to specify the default sorting order for the Music Library. Choose either Title or Library 
Number.



Personnel Preferences

This screen is used to set the preferences for the Personnel Library.      Please note, many of these 
preferences will not take effect until the program is restarted.

Fill in the appropriate text boxes to customize the corresponding drop down lists boxes in the Personnel 
Library.    This screen is used much like the other preferences screens.



Edit User Songbooks

The Edit User Songbook dialog box is accessed by selecting the Edit User Songbook menu item from the 
Songbook menu in Program Master.    This box is used to enter the various information regarding your 
user songbook or songbook.    Using this screen you can build your own Songbook    or songbook to be 
used in Program Master.    This is especially helpful if we do not support the songbook that you use, or 
you have an abundance of loose songs and choruses that you wish to compile into the form of a 
songbook.    We have provided you with 4 user songbooks to do this.

The fields are self explanatory.    Just select the songbook that you wish to edit from the Songbook drop 
down list and enter the information required.    A number can be entered into the Find field to quickly jump 
to a specific record.

Buttons:

Add New: Adds a new listing to the Songbook database.
First:    Moves to the first record entered in the Songbook database.
Previous:    Moves to the previous record in the Songbook database.
Next:    Moves to the next record in the Songbook database.
Last:    Moves to the last record entered in the Songbook database.
Delete:    Deletes the currently displayed record in the Songbook database.

The rating field is the same rating field used in the Music Library.    If you wish to change the contents of 
the Ratings drop down list, go to the Music section of the User Preferences dialog box.    To do this, select 
the Preferences menu item from the File menu.



CCLI Search

The CCLI Search box is the same as the Date Search dialog box.    However,    the text field and date field 
to search are fixed with appropriate items to perform a CCLI Search.    Enter appropriate dates and select 
OK.    For more information, consult the Date Search help topic.



Sort Library

To specify the order in which the library should be sorted, select the Sort by... item in the Edit menu. 

Select the field to use as the sort field using the drop down list.    You can also determine the order in 
which the library sorts by using the Ascending/Descending radio buttons.    [Click] [OK] to change the sort 
order of the library.

This sort will be maintained for all future searches, until another sort is performed.



Creating Library Records

There are four libraries available in School Music Master.    Each of the libraries are used to make you 
more organized and productive.    You will quickly notice that each of the libraries are user- customizable, 
so you can shape them to fit your own needs.    You have the ability to determine what appears in each of 
the drop down list boxes.    To do this, go to the Preferences dialog box by selecting the Preferences 
menu item from the File menu.

By creating your own categories in each library, you can quickly expand the four libraries to act as many 
more libraries.    For example, in the music library you can have recordings, videos, midi files, octavos, 
handbells etc. in the Type drop down list.    You can later search for one of those fields and all records 
matching that criteria will appear.    This means that instead of just a music library, you can have many 
more sub-libraries that keep you organized.    (We have taken the liberty of entering information for the 50 
most popular publishing companies in the Publishers library.    You can keep this information, or delete the 
ones that you do not use.    You can also enter your own contacts into this library.)

To create a library record:

1.    Pull down the Library menu and select the appropriate library.
2.    [Click] Add New to create a blank record.
3.    Follow the field names and enter the information required.    Drop down combo boxes let you select 
one of 10 defaults, or type in any other text .
4.    [Click] the Save button to save the information, [Click] the Add New button to add another record, or 
[Click] one of the arrow buttons to take you to a new record.    Your information will be automatically 
saved.

For more information on a specific library, select one of the libraries below:

Equipment Library
Music Library
Personnel Library
Publishers Library



Search Library

To narrow the list of songs found in the libraries, select the Search for Text item in the Edit menu, or 
[Click] the Search button in the ToolBar. 

Enter the text to search for in the appropriate text boxes.    To the right of the text boxes, there are drop 
down boxes containing field names.    You can initiate very simple or very complex searches from this 
dialog box.    Using the logical operators, And/Or at the bottom of the dialog box, you can narrow your 
search considerably.    For example in the Music Library, you can type "God"    in the first text box and 
select Title in the corresponding drop down list.    You can then type an author (i.e. "Smith" etc.) in the next 
text box, and select Author in the corresponding drop down list.    You can then select the "And" button, 
and the search will pull up every song with "God" in the title, and "Smith" in the author field.    Capital 
letters will be ignored, so typing text in either upper or lowercase will work.

You can use the "Or" button to create more complex searching.    For example, you could type the word 
"God" in two text boxes, select title in one drop down list and memo in another, and select "Or" as the 
logical operator.    This search would reveal all songs that had the word "God" in either their title OR 
memo.    Many variations of these examples can be done to create specific searches to fit your needs.    
You will find that you can find virtually any record by utilizing this searching box.    Practice searching for 
different things so you become very familiar with this process. 

One a search is finished, the records available on the main screen will usually (except Birthday, and 
Absence searches) be only those records that were found from the search.    The status bar will display if 
all or part of the records are available.



Status Bar

The status bar is located at the bottom of the School Music Master screen, and it is visible at all times.    
The right side of the screen shows the date, time, free windows memory, and free windows resources.

The left side of status bar shows different items depending on the screen displayed.    In the libraries, the 
status bar will display the number of records available (either all records in the database, or a partial list of 
records if a search was done).    In Program Master, the status bar will display the title and date of the 
current program order.    Also, the status bar    will display help tips for the buttons in the toolbar when they 
are depressed.



Birthday Search

The Birthday Search dialog box is accessed by selecting the Search for Birthdays menu item in the Edit 
menu of the Personnel Library.    It is used to search for the names of people who have birthdays on or 
between two specific dates.    The years must be entered to be a    legal date, but the years are not used 
in searching.    The search will find birthdays on/between    the months and days of the month specified.

To Search, do the following:

1. Specify the choir to search in the Choir Selection area drop down list, or select all choirs to search all of 
your choirs.
2. Specify the dates to search between in the search criteria area. 

When the search is completed the Browse List dialog is displayed to show the results of the search, if any 
names were found. You can jump directly to their personnel record by [Clicking] on their name in the list. 



Print Reports

Program Master Reports:

Program Order Report
List of Songs Report

Library Reports:

Detailed Report
List Report

From this dialog, buttons are available to    Print Preview or Print the document.



Program Order Report

The Program Order Report is a printed report of the program order contents in Program Master.    The 
report may be formatted and arranged in many ways to allow the user to print a bulletin from any program 
order.    The following options are available with this report:

Page Setup:
This allows the page margins to be set and the orientation to be set.    Also,    page numbers may be 
specified, as well as borders for the page, and borders for the columns of the program order entries.    
These options are saved when the Save button is pressed.

Title:
This allows the main title for the Program Order Report to be specified.    The text may be changed, and 
the alignment can be set.    Also, use the Font button to choose a font name, font size, and font style for 
this title.    These items are saved when the Save button is pressed.

Subtitle:
This allows the subtitle for the Program Order Report to be specified.    The options available are the 
same as those for the title.    Also, these items are saved when the Save button is pressed.

Program Title:
This allows the Program Title to be used on a Program Order Report.    The default text is the program 
title, but this may be changed or deleted as desired.    The text is not saved with the Save button, but 
other formatting options can be saved.

Column Headers:
This allows column headings to be placed above the three columns of the Program Order entries.    Also, 
formatting and justification can be specified for these headings.    If no headings are desired, just make 
the text boxes blank.    These options will be saved when the Save button is pressed.

Body Text:
These options are used to format the actual text of the Program Order entries.    Each of the three 
columns can be justified and sized differently.    Also, the text can be formatted by pressing the Font 
button.    These settings will be saved when the Save button is pressed.



List Report

The List Report is a printed report of specific fields from the Libraries or the selected Songbook.    The 
general format of this report is several columns, one per field, listed down the page.    One record is 
printed on one row across the page.    This report is very useful for printing only the desired fields for 
every record in a concise report.    The records printed will be only those available at the time.    All records 
may be printed if all records are available, or only certain records may be printed by first doing a search to 
reduce the number available, and then printing.    The report may be formatted and arranged in many 
ways to allow the user to print a specific list of fields.    The following options are available with this report:

Page Setup:
This allows the page margins to be set and the orientation to be set.    Also,    page numbers may be 
specified, as well as borders for the page, and borders for the columns .    These options are saved when 
the Save button is pressed.

Title:
This allows the main title for the List Report to be specified.    The text may be changed, and the alignment 
can be set.    Also, use the Font button to choose a font name, font size, and font style for this title.    
These items are saved when the Save button is pressed.

Subtitle:
This allows the subtitle for the List Report to be specified.    The options available are the same as those 
for the title.    Also, these items are saved when the Save button is pressed.

Column Headers:
This allows column headings to be formatted.      Also, justification, font name, font size, and font style can 
be specified for these headings.      A check box is available to place a line under the headings.    These 
options will be saved when the Save button is pressed.

Body Text:
These options are used to format the actual text of the List Report.    These settings will be saved when 
the Save button is pressed.

Column Fields:
This options allows the desired fields to be chosen for the List Report.    Up to 12 fields may be chosen for 
the report, and ordered in any way desired.    The list of fields to be printed will be printed with the first 
field listed as the first field on the left.    Columns will be automatically resized as more fields are added.    
This list of fields is saved when the Save button is pressed.



Detailed Report

The Detailed Report is a printed report of all available fields for a records or for all    available records from 
the Libraries.    The general format of this report is one record at a time, all fields, printed at the left 
margin.    One or all records may be printed .    This report is very useful for printing all of the details and 
information about one or all records, although the report could get quite lengthy for a large database, but 
the number of records could be narrowed by searching for specific information.    The following options are 
available with this report:

Page Setup:
This allows the page margins to be set and the orientation to be set.    Also,    page numbers may be 
specified, as well as borders for the page.    These options are saved when the Save button is pressed.

Title:
This allows the main title for the Detailed Report to be specified.    The text may be changed, and the 
alignment can be set.    Also, use the Font button to choose a font name, font size, and font style for this 
title.    These items are saved when the Save button is pressed.

Subtitle:
This allows the subtitle for the Detailed Report to be specified.    The options available are the same as 
those for the title.    Also, these items are saved when the Save button is pressed.

Body Text:
These options are used to format the actual text of the Detailed    Report.    Options are available to print 
one records or to print all available records.    The options to not print blank fields, if checked, will not print 
lines for the fields in each records that are blank.    This option helps to keep the length of the report down. 
These settings will be saved when the Save button is pressed.



Print Labels

This dialog box is used to print a set of labels for the Library database records.    Only the currently 
available records will be printed on labels.    This allows the user to search or sort in any particular way, 
and then print a set of labels.    For example, to print mailing labels for only members of your Adult I choir, 
search for only members of Adult I choir, and then select Print Lables from the File menu.    Now, only the 
records that were found will be printed on labels.    The following options are available in this dialog box:

Label Type:
This allows the user to choose one of many available label types.    Over 30 standard Avery brand labels 
are supported, plus two custom labels can be defined for each library.    Choose the preferred label type 
from the combo box list of label types.    To define a custom label, click the Edit Custom button to bring up 
the Custom Label Setup dialog.    Enter measurements for the desired label type in this dialog.

Data to Print:
Choose the fields for the labels.    The fields will be printed as listed in the fields to print list from top to 
bottom on each label.    Libraries which allow addresses will show a predefined Name/Address option.    
This option is already defined to print a standard name and address label from the library records.

Text Formatting:
Choose the font name, font size, and font style for the label text.    Also, an offset can be entered.    Use 
this offset to align text on the label more accurately, and this may also be necessary if your printer has 
trouble printing on the labels aligned properly.

From this dialog, buttons are available to    Print Preview or Print the document.



Custom Label Setup

Use this dialog box to define the two Custom Label types.    Different custom label types may be defined 
for each library.

Enter the measurements for the label.    Use the picture as a guide to see how the measurements are 
determined.    It is important that these measurements be as close as possible for the labels to print 
properly.

After the measurements have been entered, choose [OK] to save the new label definition.



Search Multiple Songbooks

This dialog box displays a list of all available songbooks when the multiple songbook search command is 
selected.

Choose any combinations of songbooks to be searched.    The All button will select all songbooks, and the 
none button will deselect all songbooks.



Print Preview

This dialog box allows the document to be printed to be previewed.    The percent buttons on the bottom 
left of this dialog allow the zoom percentage to be changed.    The arrows and page number controls allow 
the page previewed to be changed.    The buttons allow the page to be moved forward or backward by 
one page, or to jump to either end of the document.

Select Print to print the document in the print preview window.

Select Close to return to the previous dialog box.



Network Installations

School Music Master can be installed on a network in one of several ways.

Peer to Peer Networks (Windows for Workgroups):
Install a separate copy of School Music Master on each computer that plans to use School Music Master. 
Select a computer for the location of the data files.    On the other computers, select the master 
computer's School Music Master directory as the directory for the data files.    This will allow all computer's 
on the network to use the same set of data files.    Everyone will have access to the data.    The *.mdb and 
*.ldb files on the non-master computers may be deleted from all computers except the master, since the 
data from the master computer will be used.

For example, in an office with three computers, the Music Instructor may want to keep the master data on 
thier computer.    The other two computers will be set up to access the database files from the Music 
Instructor's computer.

1) Install School Music Master on all three computers    (for example in a c:\smm directory)
2) If the two secondary computers interpret the Music Instructor's hard drive as E: for example, set the 
database directory location in preferences on the two secondary computers to be E:\SMM.    These two 
computer's will now use the Music Instructor's database files.
3) The *.mdb and *.ldb files on the two secondary computers may be deleted.

Note: For this to work properly, the master computer must share their hard drive with other users, or at 
least share the SMM directory.    Also, the computer with the master data files will have to be turned on, 
with windows running, and connected to the network anytime the secondary computers need to use 
School Music Master.

Server Based Networks:
The installation of School Music Master on a server based network is very similar to that on a peer to peer 
network.      School Music Master cannot be installed on the server, it must be installed on each individual 
computer.    Then, the data files may be placed on a server.    Copy the *.mdb and *.ldb data files onto the 
server.    From each copy of School Music Master, specify the data directory in preferences to be the 
directory of the SMM data files on the server.    All users will now have access to the same set of data files 
on the server.    Performance will not be sacrificed.

Note: On any network installation, be sure that two users do not open and modify the same library, 
songbook, or worship database or some data may be lost.




